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Introduction

The SimKits Panel Designer outs are according to what you wish. That is the 
is a software program which allows you to design a responsibility of yourself, so we advise to check and 
metal aircraft panel without the use of expensive CAD double check.
programs and does not require any knowledge of The next step is that the file is forwarded to a high 
Computer Aided Design. speed laser cutting machine. A large X-Y table with 

an extreme powerful laser, able to cut through metal.
The result of the use of this program is a file which 
contains the positions of the chosen cut outs and a The result is a clean cut metal panel which 
calculation of the expected costs. dimensions of cut-outs are clean an precise.

The program is distributed free of charge under the What metal is used?
condition that is used only to design an aircraft panel The metal panel is produced from so-called Zincor 
for a flight simulator and that the output of this plate, which is anti corrosion coated metal. The 
program is used to order this aircraft panel from TRC thickness of the metal is 1.5 mm. (approx. 0.059”).
Development through its SimKits product service. No other type of material can be ordered. This is due 

to the fact that orders which come in during a period 
The program is contineously under development but of 14 days are combined into a single cutting job and 
is not created for the purpose to replace a real CAD the material used is purchased by us in large 
program. Therefore the output of this program does quantities.
not contain any vector drawings. (if we would handle individual orders, we could not 
The output of this program is converted into the real deliver an individually cut panel below € 600.00 to € 
vector graphics when the output file is received by 800.00)
TRC Development and is used thereafter to feed a 
laser metal cutting machine, which reproduces in Not painted
detail the designed panel into a metal plate. The panel, once cut, is not finished by paint, since 

there are so many different wishes for paint and color. 
The software contains a library of pre-programmed However the panel is easily painted by the use of car 
cut-outs. These cut-outs can be placed onto a pre- paint in a spray can from your local car paint store.
programmed or self dimensioned panel lay-out.

What does it cost?
The main pre-programmed panel lay out fits exactly The SimKits Panel Designer has a built-in calculation 
in the flight simulator cabinet made of vacuum formed system, which automatically calculates the cost of 
plastic, creating thereby a realistic and professional your panel, depending on the panel size and the 
flight simulator (see details of the flight simulator number of cut-outs / size of cut-outs used.
cabinet on the SimKits website). It also calculates the approx. shipping costs, so it 

gives you an idea of what your panel design would 
You can position cut-outs by entering the exact X and cost.
Y position and when placed on the panel lay-out you 
can alter the position by double clicking on it to open The final costs are recalculated bij our sales 
the dialog box again or even drag the cut-out to a department when you send in the file and you will 
new position. Fine tuning of the position is realized by receive a confirmation and a JPG of your panel 
opening the dialog box and changing the X and Y design as an extra check.
coordinates.
Its so easy, you design a metal panel in minutes Directions are given how to pay for the panel design. 
rather than days. The receipt of the payment is considered as the final 

order and agreement to cut this panel.
Once finished, just send the output file (the extension You will also receive and estimated date of shipment.
of the file is .SPF) to:
paneldesign@simkits.com, wait for the price How do I order my panel?
confirmation and pay for the panel on the website When you are finished with the panel design, and 
according to the instructions received by email. have saved your work, there will be a file with the 

extension .SPF on your computer.
Generally, the panel is shipped to you within 3 weeks 
after receipt of the cutting file and your payment Send this file to paneldesign@simkits.com and you 
(payment is accepted by credit card or bank wire prior will receive confirmation of the received file within 24 
to the cutting of the panel. hours.

How is the panel produced? Warning
The file you have generated with the SimKits Panel Check and double check your design. Errors result in 
Designer is first converted to a DXF format and a wrong panel and SimKits/TRC Development is not 
checked against impossible cutting. Of course, our responsible for errors in the final product other than 
system cannot check if the positioning of your cut- errors created by SimKits/TRC Development.



Using the SimKits Panel Designer

The main screen
The SimKits Panel Designer program is very easy to use. On the left of the main screen, all libraries are visible as 
thumbnails. On the top row, the pull down menus File, Tools, Panel and Help are visible.

The File Menu The Tools Menu The Panel Menu The Help Menu
The File Menu let  you The Tools Menu gives The SimKits Panel The Help menu shows 
open existing panel you access to the built-in Designer comes with a the release version of the 
designs. Create a new calculation system, which pre-programmed blank software when you click 
Panel Design, Saving can give you a cost panel in the precise on About. Use this 
them under the same estimated for the metal format for the large function to check if you 
name or a new name panel you are designing cabinet or you can create  use the latest version. If 
and enables you to print in real time. You can call your own custom panel not, please download the 
out the panel design for it up at any time to see outline here. latest version from the 
your reference. what your panel would SimKits website.

cost.

Positioning
Here you find the X and Y position of the selected cut-out.
When a cut-out is selected, a red square is positioned around it.

Panel
Pre-defined panel outline with mounting holes. The pre-defined 
panel fits exactly into the TRC472 type cabinet available from the 
SimKits Website.



Using the SimKits Panel Designer

Cut-out Groups
There are several types of cut-outs. Most cut-outs are available from the built-in library of the SimKits Panel 
Designer. There are also two cut-out, which dimension you can set yourself. A rectangle cut-out enables you to set 
the width and height of the rectangle, while also a circle cut-out command is available, which allows you to create 
any size of circle or even ellipse. When you click on a thumbnail, a dialog box opens which will ask you the width 
and height (for circle and rectangle cut-outs only) and the X and Y position (for all library cut-outs).

Clicking on a thumb-nail in the left column
Opens a dialog box where you can enter the X and Y position for a cut-out. When clicking on one of the two 
thumbnails in the utmost upper left hand corner, the dialog box also enables you to enter the width and height of 
the cut-out.

Clicking on a positioned cut-out
Selects the cut-out. Holding down the left mouse button allows you to drag the cut-out to a new position, When the 
left mouse button is released, the dialog box opens again and let you eventually fine tune the new position. Clicking 
on OK places the cut-out on the new position.

Double clicking on a positioned cut-out
Opens the dialog box and let you set new values in the X and Y positioning fields.

Right clicking on a cut-out
Opens a dialog box to enable a delete action or an edit action.
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Choosing your panel or design your own outline

Panel
The SimKits Panel Designer has the possibility to choose for a pre-designed panel with moutning holes which 
fits exactly in the large cabinet an glareshield, made from vacuum formed plastics. (See more details on the 
SimKits website).

When you choose the pre-designed panel, you can start positioning the desired cut-outs immediately.

When you would like to design your own panel outline, please choose for Custom Panel in the Panel pull down 
menu. Once you have created a custom panel, you can always change the dimensions or corner roundings by 
clicking on Adjust Panel Parameters in the Panel pull down menu.

Dimensioning a Custom Panel
Sinced the SimKits Panel Designer is not a CAD program (which produces vectorised drawings), the design of a 
Custom dimensioned panel is limited. You can choose a rectangle panel and round off the corners up to your 
own wish.

When you enter a Radius for a corner, the  number you enter produces a quarter of a circle at the position of the 
chosen corner. For example, when you chose for the upper left corner a radius of 50.000 mm. (50 mm.), the 
quarter circle is part of a whole circle with a diameter of 100 mm.



How to order the designed Panel from SimKits

Ordering the designed panel from SimKits
The file, which contains the panel you have designed using the SimKits Panel Designer has the extension 
*.SPF.

When you have checked (and double checked) your metal panel design, you should send this file to:

paneldesign@simkits.com

Upon receipt - and during working hours - this file is checked on validity and a final price is sent to you by email, 
together with the invitation to initiate the final order of your metal panel.
In the email is explained how you can pay for this product.

Once the payment is received, the production process starts and cannot be stopped anymore.

The delivery time is approx. 2 to 3 weeks after the final order (either credit card order via tghe website or 
prepayment on our bank account) has been received. 



Large Gauge
This is the standard cut out as used for the so called 
General Instrument gauge. With a General 
Instruments gauge you can create a.o. an Airspeed 
Indicator, a Tacho Meter and a Vertical Speed 
Indicator.

The dimensions are in millimeters. The scale is 
100%, but due to the non-precision of most printers, 
it is not recommended to print this sheet and use it 
for measurements!

The overall size of this cut out is 79 x 79 mm.
Size of mounting holes: 4 mm.
Size of cut out: 79 mm.
Center cut out to center mounting holes: 46 mm.
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Large Gauge with 1 Dial
This is the cut out as used for the Altimeter gauge, 
the VOR1, VOR2 and ADF gauge.

The dimensions are in millimeters. The scale is 
100%, but due to the non-precision of most printers, 
it is not recommended to print this sheet and use it 
for measurements!

The overall size of this cut out is 79 x 79 mm.
Size of mounting holes: 4 mm.
Size of large cut out: 79 mm.
Size of  cut out for dial: 11.04 x 9 mm.
Center large cut out to center mounting holes: 46 
mm.

Details of cut-out library
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Large Gauge with 2 Dials
This is the cut out as used for the Heading Indicator.

The dimensions are in millimeters. The scale is 
100%, but due to the non-precision of most printers, 
it is not recommended to print this sheet and use it 
for measurements!

The overall size of this cut out is 79 x 79 mm.
Size of mounting holes: 4 mm.
Size of large cut out: 79.2 mm.
Size of  cut out for dials: 11.21 x 9 mm.
Center large cut out to center mounting holes: 
46 mm.

Flap Switch and indicator
This is the cut out as used for the Flap Switch and 
indicator driven by servo motor. (See the SimKits 
website for more details on this product.)
The dimensions are in millimeters. The scale is 
100%, but due to the non-precision of most printers, 
it is not recommended to print this sheet and use it 
for measurements!

The overall size of this cut out (WxH) is 41.526 x 
55.947 mm..

Size of mounting holes: 4.5 mm.
Size of large cut out: 10.92 x 47.97 mm.
Size of  small cut out: 2.74 x 44.00 mm..
Center of mounting holes: 37.03 x 51.45 mm.
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Rocker Switch
This is the cut out for the Rocker Switch as used for 
the main and avionics switches. (See the SimKits 
website for more details on this product.)
The dimensions are in millimeters. The scale is 
100%, but due to the non-precision of most printers, 
it is not recommended to print this sheet and use it 
for measurements!
The size of this cut out is 12 x 28.61 mm.

Details of cut-out library



Trim Wheel (vertical or horizontal)
This is the cut out as used for the Trim Wheel 
assembly. There are two identical cut outs. One can 
be used for vertical mount (pitch trim) the other for 
horizontal mount (rudder trim) or other purpose.
(See the SimKits website for more details on this 
product.)

The dimensions are in millimeters. The scale is 
100%, but due to the non-precision of most printers, 
it is not recommended to print this sheet and use it 
for measurements!

The overall size of this cut out is 56 x 85 mm.
Size of mounting holes: 4.5 mm.
Size of large cut out: 85 x 14.95 mm.
Size of  small cut out: 30 x 5.12 mm.

Warning Panel
This is the cut out as used for the Warning Panel assembly. (See the SimKits website for more details on this 
product.)

The dimensions are in millimeters. The scale is 100%, but due to the non-precision of most printers, it is not 
recommended to print this sheet and use it for measurements!

The overall size of this cut out is 111.62 x 22.72 mm.
Size of mounting holes: 4 mm.
Size of hole for tumbler switch: 7 mm.
Size of large cut out: 75.66 x 22.72 mm.
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Details of cut-out library



Yoke Mount 
This is the cut out as used for the Yoke mount in the 
front panel. (See the SimKits website for more 
details on this product.)
The dimensions are in millimeters. The scale is 
100%, but due to the non-precision of most printers, 
it is not recommended to print this sheet and use it 
for measurements!
The overall size of this cut out is 39.14 x 39.14 mm.
Size of mounting holes: 5.2 mm.
Size of large hole: 25 mm.
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Small Gauge
This is the standard cut out as used for the small 
gauges. The dimensions are in millimeters. The 
scale is 100%, but due to the non-precision of most 
printers, it is not recommended to print this sheet 
and use it for measurements! 
The total size of this cut out is 56.735 x 56.735 mm.
Size of mounting holes: 3.55 mm.
Size of large hole: 56.735 mm.
Center cut out to center mounting holes: 46 mm.
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Slotted 3-pole Switch
This is the standard cut out as used for the Tank 
Switch. (See the SimKits website for more details on 
this product.) The dimensions are in millimeters. 
The scale is 100%, but due to the non-precision of 
most printers, it is not recommended to print this 
sheet and use it for measurements!
The overall size of this cut out is 14 x 11.93 mm.
Size of the slot: 2.5 x 2.13 mm.
Diameter of center hole: 11.93 mm.11.93 mm11.93 mm
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Tumbler Switch
This is the standard cut out as used for the Tumbler 
Switch. (See the SimKits website for more details on 
this product.) The dimensions are in millimeters. 
The scale is 100%, but due to the non-precision of 
most printers, it is not recommended to print this 
sheet and use it for measurements!
Diameter of the hole: 11.93 mm.

11.80 mm11.80 mm

5.00 mm5.00 mm

Mounting Hole
A 5 mm. mounting hole. The dimensions are in 
millimeters. The scale is 100%, but due to the non-
precision of most printers, it is not recommended to 
print this sheet and use it for measurements!

Details of cut-out library



Circuit Breaker 
This is the cut out as used for the Circuit Breaker in 
the front panel. (See the SimKits website for more 
details on this product.) The dimensions are in 
millimeters. The scale is 100%, but due to the non-
precision of most printers, it is not recommended to 
print this sheet and use it for measurements!

The overall size of this cut out is 12.5 x 11.92 mm.
Diameter of hole without slotted sides: 12.5 mm.
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Key Lock 
This is the cut out as used for the Key Lock Switch 
in the front panel. (See the SimKits website for more 
details on this product.) The dimensions are in 
millimeters. The scale is 100%, but due to the non-
precision of most printers, it is not recommended to 
print this sheet and use it for measurements!
The overall size of this cut out is 19.55 x 19.55 mm.
Diameter of hole without slotted sides: 16.5 mm.
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Throttle
This is the cut out as used for the Cessna style 
Throttle. (See the SimKits website for more details 
on this product.)
The dimensions are in millimeters. The scale is 
100%, but due to the non-precision of most printers, 
it is not recommended to print this sheet and use it 
for measurements!
The diameter of this cut out is 13.50 mm.

Mixture / Propeller Adjust
This is the cut out as used for the Cessna style 
Mixture and Propeller Adjust. (See the SimKits 
website for more details on this product.)
The dimensions are in millimeters. The scale is 
100%, but due to the non-precision of most printers, 
it is not recommended to print this sheet and use it 
for measurements!
The diameter of this cut out is 19 mm.
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Potentiometer
This is the cut out as used for the light regulating 
potentiometer. (See the SimKits website for more 
details on this product.)
The dimensions are in millimeters. The scale is 
100%, but due to the non-precision of most printers, 
it is not recommended to print this sheet and use it 
for measurements!
The diameter of the large cut out is 7.5 mm.
The diameter of the small cut out is 2.22 mm.

Details of cut-out library
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Gear Switch
This is the cut out as used for the Gear Switch with 
the Red and Green LED indicator in the front panel. 
(See the SimKits website for more details on this 
product.)

The dimensions are in millimeters. The scale is 
100%, but due to the non-precision of most printers, 
it is not recommended to print this sheet and use it 
for measurements!
The overall size of this cut out is 85.74 x 27.70 mm.
Size of mounting holes: 4.5 mm.
Size of large hole: 4.95 x 65  mm.
Size of the holes for the LEDs 5.80 mm.
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Details of cut-out library
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Details of pre-programmed Cessna 172 Skyhawk style panel

Cessna 172 Skyhawk panel
The Cessna 172 Skyhawk panel outline is an exact replica of the original panel. It includes mounting holes 
which fit exactly the mounting holes of the large TRC472 style cabinet and glare shield.

Design your own professional flight simulator using this pre-programmed panel and use cabinet and glareshield 

to finish a cockpit panel design which you cannot distinguish from a real aircraft panel!
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